UNIT -2
WEB APPLICATION : Networking Fundamentals

Network: A computer network is a collection of computers and other hardware
components interconnected by communication channels (cables or satellites) that
allow sharing of resources and information.

Networks are desighed using the following architecture:

Peer to peer (P2P): Networkn which all computers have an equal status are called
peer to peer networks. Generally in such a network each terminal has an equally
competent CPU.

Client-Server: Networks, in which certain computers ha&e special dedicated tasks,
providing services to other computers (in the ne ) are called client server
networks. The computer(s) which provide servic e called servers and the ones
that use these services are called clients.

Types of Network: Q"}) A

There are 2 major types of networ ‘3\
1) LAN:- LANis Local Area Ng@(rork Itis used to connect computers and devices
within a small geogra@/ | area such as home, school etc.

2) WAN:- WAN is Wide Area Network. It is used to connect computers in a
broad area such as national and international boundaries.
Eg. Internet.

Internet: Internet is a global system of interconnected computer networks that use
the standard Internet protocol suite to serve billions of users worldwide. It is a
network of networks that consists of millions of private, public, academic, business,
and government networks.

World Wide Web: World Wide Web (abbreviated as WWW or W3, commonly
known as the Web), is a system of interlinked hypertext documents accessed via
the Internet.



Web Browser: A Web Browser is software used to view Web sites and acts as an
interface between the user and the World Wide Web.

Web Server: A Web server is a computer that stores web sites and their related
files for viewing on the Internet.

Uses of Network:-

1) Data Sharing: We can share data like text files, documents, audio and video
files to other users with the help of Networking.

2) Hardware Sharing: Hardware components like printers, scanners etc. can
also be shared with the help of networking.

3) Internet Access Sharing: Through networking we can access a single internet
connection on multiple computers within a network.

4) Usage of Network Based Applications: Applications like chat applications,
audio and video calling is an another advantage.&

Getting Access to the Internet:- Q/Q*
To use Internet we need the following:- Q/
1) ISP:- ISP is Internet Service Provider, Iﬁ?an organization which provides us
with the access of Internet. For eg. "L, Airtel, MTNL etc.
2) Modem:- The word m is derived from its function
Modulator/DEModulator. | a device which is used to convert digital
computer signals into ani;&‘signals and vice-versa.

Types of Internet Connggti@tv
Types of Internet Connec\tivity can be broadly categorized into Wired Technology
and Wireless Technology.

Wired Technology:-

1) Dial-up:- It uses the facilities of the Public Switched Telephone Network
(PSTN) to establish a internet connection via telephone lines using a device
called MODEM. Users dial a number and get access to internet. Dial-up
connections are extremely slow.

2) DSL:- DSL is Digital Subscriber Line provides internet connectivity by
transmitting digital data over wires of a local telephone network. It enables
the use of Telephone and Data Transmission on a single telephone line. For
using DSL Connection, we need a DSL modem and a subscription.



3) Cable Internet Access:- It is a form of broadband Internet access that uses
the cable TV infrastructure. It is provided through existing cable TV networks
and it is similar to DSL.

Wireless Technology:-

1) 3G:- 3G, is short for 3™ Generation. It is a set of standards used for Mobile
devices and mobile telecommunication services and networks. If the phone
supports 3G, then high speed internet connectivity can be accessed through
its subscription.

High-Speed Downlink Packet Access (HSDPA) is a 3G protocol (standard)
that allows higher data transfer speeds and capacity.

2) WiMAX:- WiMAX is Worldwide Interoperability for Microwave Access is a
wireless communications standard designed to provide mobile broadband
connectivity across cities and countries through v&Qety of devices. Itis a long
range system. It is beneficial where there isQ‘ﬁbﬁculty in laying out cables
and wires.

3) Wi-Fi:- It is a popular technology use%%@transfer data wirelessly over a
network. Wi-Fi stands for Wireless FideNty. The wireless network is formed
through a device called Wireless @g Point (WAP). It is beneficial as there
is no need of laying out wiresjs)\Qbr nsferring data.

Data Transfer On the Internet ;.-f?“

e The data is broken up intodi }/Bf same sized pieces called packets.

e A header is added to packet explaining where the data has come from,
where it should end up and where it fits in with the rest of the packets.

e Each packet is sent from computer to computer until it finds its destination. All
packets may not take the same route.

e At the destination, the packets are examined. If any packets are missing or
damaged, a message is sent asking for them to be resent. This continues until all
packets have been received intact.

e The packets are now reassembled into their original form. All this done in
seconds!

Session 3 : INTRODUCTION TO THE INSTANT MESSAGING

INSTANT MESSAGING




Instant Messaging (IM) is a form of communication over the internet that offers an
instantaneous transmission of text-based messages from sender to receiver. Most
IM software includes the option to transfer files, audio chat, video, images etc.

Key Features of IM are :-
1) Text message can be sent from one person to another(similar to SMS)
2) Audio calling and conferencing
3) Video calling and conferencing
4) File Transfers
5) Message History (Save messages for future reference)

Types of Instant Messaging Software &
There are two kinds of IM Software:- \>
1) Application Based:- These software are d aded and installed on user’s
computer. Eg. Google Talk , Yahoo! enger , Skype , Window Live

Messenger , Rediff Bol etc.
2) Web Based:- They are accessed usi rowsers such as Internet Explorer etc.
Eg. MSN Web Messenger, Yahg\ essenger for the Web , Meebo , IMO etc.

" o

A blog is a discussion style sed by non-technical users for creating personal
web pages. Blog is simil an online personal diary and similar to use. A blog is
used to convey messages, events, news, announcements etc.

Blogs are usually managed through web browser which needs an internet
connection. A blog can also be created through Offline Blog Software and later
publish the content when the internet connection is available.

Examples of Websites that offer blog services:-

www.blogger.com

www.wordpress.com

www.weebly.com

www.blog.com

ONLINE TRANSACTIONS
The transactions over the internet are called Online Transactions



http://www.blogger.com/
http://www.wordpress.com/
http://www.weebly.com/
http://www.blog.com/

Like purchasing of goods, selling of goods, booking a ticket, payment of fees etc. all
comes under the category of Online transactions.

Examples of Online Transaction websites:-
1) For Buying Goods :- amazon, jabong, myntra, flipkart , ebay etc.
2) For Booking of Tickets :- IRCTC, Redbus etc.
3) For Payment of School Fee :- epay.unionbankofindia.co.in/kvfee
Payment Tools to use Online Transactions:-
For completing an online transaction we must need:-
1) Valid Debit Card
2) Valid Credit Card
3) Net Banking Subscription

INTERNET SECURITY

It is a branch of computer security specifically re@to the internet, involving
browser security and also network security. Q,Q/

Objectives of Internet Security:- @

The main objective of internet security{&%”establish rules and measures to use
against attacks over the internet. ‘33%

Online Threats ‘??“
The threats / vulnerabiliti t%‘t uses World Wide Web (Internet) to facilitate
crimes are called Online hgéats.

Like:-

1) Phishing :- The act of acquiring personal / private and sensitive data from
personal computers for use in fraudulent activities. For eg. Mails from
unknown persons that ask for your credit / debit card details.

2) Email spoofing :- It is the creation of email messages with a forged sender
address. For eg. Sending an email with a forged email address which appears
to be original. These mails are infected mails which contain worms.

3) Chat Spoofing:- Spoofing means hoakx, trick, or deceive which contains false

information. Hiding / Faking the identity of another person over the internet
is called chat spoofing.

BEST PRACTICES FOR SECURITY OVER INTERNET




. Use strong passwords: A combination of alphanumeric and special

characters could be used for creating a password that is not so easy to crack

or guessed by other users.

General guidelines for strong password

a) Keep the length of the password at least 12-14 characters if permitted.

b) Avoid keeping passwords based on repetition words, dictionary words,
usernames, pet names etc.

¢) Include numbers and symbols in passwords.

d) Use Capital and lowercase letters.

e) Avoid using same password for multiple sites or purposes.

f) Avoid using something that the public or workmates know you strongly
like or dislikes.

. Backup your data: Always keep copies of data in CD, pendrives etc, so it

could be helpful in situation when there is a Ioss&(data.

. Use Encryption software: Use encrypted are available within the

operating software to protect data from u orized users.

Keep username and password privajeﬁaver save passwords or usernames

on computers that are used in sh%ﬂ)é’nvironments like net café.

. Registering with website: Rea:d%?m acy policy whenever you register with a
website, the policy will inqr{).d information about how the website use

personal data. Ve

. Do not share person i%:)rmation: Be cautious when filling out forms on
internet. Because@r personal information or emails could be used by

unauthorized users to send fake or unwanted emails. So, first research and

verify if it’s a trusted website or not before providing personal information

to any website.

. Secure transactions: It is always recommended to use only secure websites

for online shopping or transactions, because these websites store your credit

card or online banking personal information. Verify if the website uses secure

transaction, usually it is indicated through a digital certificate represented as

a golden lock in the web browser’s address bar.

. Use Antivirus and antispyware software: These softwares protect your

computer from any changes by malwares/threats. Keep these softwares up

to date.

. Do not immediately respond to mails from unknown users: Some mails,

that promise you jobs or announce lottery results, may contain virus or




scripts or they can try to gather your personal information. Never open the
attachments from unknown persons.
10.Install firewalls: Firewalls keep your system and network secure. They could
be software or hardware. So, Install and configure your firewall.
11.Regularly update your operating system and software applications.
12.When you visit websites, cookies are created on your system that may
contain your personal or logon details. Clear browser cookies frequently so
that your logon details could not be tracked by unauthorized users.

SESSION 1:-WORKING WITH ACCESSIBILITY OPTIONS

Computer Accessibility :- It refers to the user friendliness of a computer system for
all, regardless of their disability. It enables a person with a disability or impairment
to use a computer. It is also known as Assistive Technol&gy.
There are numerous types of impairment that i computer usage. These
includes:-
1) Cognitive impairments and learning dis%g(w'es, such as dyslexia, autism, and
D

attention deficit-hyperactivity disorder HD).
2) Visual impairment, such as low- ) complete or partial blindness, and

color blindness.
3) Hearing impairment includi afness.
4) Motor or dexterity impai R’fént, such as paralysis, cerebral palsy, or carpal
tunnel syndrome and@ titive strain injury.
These accessibility optio&&%ﬁfe used to customize the way your keyboard, display,
or mouse function.

Various Accessibility Options

1) Sticky Keys:- It is an accessibility feature to help computer users with physical
disabilities. It allows the user to press and release a modifier key, such as Ctrl,
Alt, Shift etc. and have it remain active until any other key is pressed.

2) Filter Keys:- It is an accessibility feature that tells the keyboard to ignore
repeated key strokes, making typing easier for people with hand tremors.

3) Toggle Keys:- It is an accessibility feature which is designed for people who
have vision impairment or cognitive disabilities. When toggle keys are turned
on, the computer emits a high sound when the locking keys, such as Caps
Lock, Num Lock, Scroll Lock are switched on and a low sound when they are
switched off.




4)

5)

6)

7)

8)

9)

Sound Sentry:- It is designed for the users with auditory impairments. It
generates warnings, such as blinking title bar or a flashing border, whenever
the computer generates a sound.

Show Sounds:- It instructs applications that convey information by sound, to
also provide information visually, through text captions or informative icons.
High Contrast:- It is an accessibility feature to assist people with vision
impairment. It can change the size and color of fonts and the background for
ease of viewing.

Cursor Options:- It is an accessibility feature that assists people with vision
impairment by changing the blink rate and width of the cursor.

Mouse Keys:- It is an accessibility feature that assists people who have
difficulty using a mouse. This option uses the keyboard as a pointing device
instead of a mouse.

Serial keys:- It is an accessibility feature thab(assists people that have
difficulty in using a keyboard or a mouse or bo ey can use special devices
such as Sip, Puff and Breath Switches toQ/ vide input to the computer

through serial ports. @

=== ================== :é{:j_& === =================



Unit-3
Word Processing

Session 1: Modifying Layout of a paragraph

Steps to Set the paragraph layout:-

1.
2.

Open a word document. Click on Page Layout tab on the ribbon.
Click on Mthe icon under Paragraph group. A paragraph dialog box will appear.
Select the desired alignment, line spacing etc.

Click on Tab button. A tab dialog box will appear.

Specify the tab stop position by mentioning the stopping position in the Tab stop
position box. After specifying the tab stop position click on Set button and the Tabs
window appears.

. Click OK. The ruler of the document will be marked v@th a L shaped symbol at 2”,

meaning that the tab stop position has been set ai;\th,at position.
(Now when you press the tab key, the cursor wit I}:futomatlcally jump from its initial
position to the next tab stop position.) .{\/

Session 2 : Managing Headers

\\«/
Header:- Headers are text or im@g?included at the top of the page. They usually
contain important information §}uéh‘ as company or department name, logo, page
numbers etc. ?,\’““‘

Steps to include heade |n é document

1. Click on the Insert on the Ribbon.

2. Click on the optlon&ader in the Header & Footer group.

3. Adrop down list will appear. Insert any of the predefined options from the list.

4. You can insert Page number, Date & Time or any picture or clip art in the header area.

Session 3 : Managing Footers

Footer :- Footers are text or image included at the bottom of the page and may repeat in
all pages of the document. You can include page number, date & time, pictures or clip art
in the footer area.

Steps to include footer in a document

1. Click on the Insert tab on the Ribbon.

2. Click on the option Footer in the Header & Footer group.

3. A drop down list will appear. Insert any of the predefined footer options from the list.

Session 4: Managing Styles

Styles:- Styles or Style sets are pre-defined or customized options used for creating good
looking profession documents with least efforts.




Steps to apply and manage styles:

1. Locate the Style group under Home tab.You can view list of styles in Styles Group.

2. Toview the list of style sets available, point to Style Set under Change Styles option.
A drop down with different styles will be displayed.
Select any of the styles listed by clicking it.

Session 5:- Document Template
Template:- Templates or document templates refer to a sample fill-in-the-blank
document that can help in saving time. They may have sample content, themes, etc.

Steps to view & use sample templates:-

1. Go to File->New. Different types of templates will be displayed.

2. Select any of the templates by double-clicking on it. Now you can use this template
and customize the contents according to your needs.

Steps to create a template are:- ”\\/:&

1. Create a word document that will serve as the t ate.

2. Click on File->Save As and give the template a hame. Select Word Template from the
Save as type: drop down list. '{\/
Click on Save. Ny

v

R |
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Session 6 : Working with Page and Section Br(e%l?s
Page and Section Breaks can be used to separdte a document into sections. To separate a section
in a portion use Section Break. To stargj\ﬁé‘w page in a document use Page Break.

O
Steps to Use Section Break and 'Break :-

1. Click on the Page Lay mftab on the ribbon.

2. Click on the option Breaks in the Page Setup group.

3. Adropdown list with options of different types of breaks appears.

Steps to Delete Section / Page Break
1. Click on the Section / Page Break.
2. Press Delete on your keyboard and the section / page break is removed.

Use of Page Break:- A page break can be inserted anywhere in a document to force the end of a
page and the beginning of a new one.

Use of Section Break :- Section Break add flexibility to formatting your document. You can create
different headers and footers, different footnote numbering, change the layout of columns,
change page borders for different pages and even change the page layout of the same document.
Using Section breaks is like having mini-documents in one large document.

Session 7: Applying Character Formats




Character Formatting:- To change look and design of characters is called character formatting.

Different options to make changes to a character or word:-

1.

LWONSOULAEWN
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Font Face

Font Size

Grow Font - to make font size larger than the current size by the specified point.
Shrink Font - to make font size smaller than the current size by the specified point.
Strikethrough — to make a strike through the middle of the selected text.
Subscript — to make the selected text lower than the normal text position.
Superscript — to make the selected text higher than the normal text position.

Clear Formatting — used to clear the character formatting.

Text Highlight Colour - used to change the background colour of the text.

. Font Colour — used to change the colour of the text.
. Change Case — helps us to change the text case to capital letters or small letter.

Different change case options are :-

(i) Sentence Case:- the first character in the First,word of the selected sentence
will be in Upper case and rest of charactefsiwill be in small case.

(ii) Lowercase:- selected text will be converted to small letters.

(iii) Uppercase:- selected text will be c,ghtl\?(ted to Capital letters.

(iv) Capitalize Each Word:- the first character in all the words of the selected
sentence will be converted to\Capital letter.

(v) tOGGLE cASE:- the small let ”,w;in the selected text will be converted to capital
letters and capital letters'will be converted to small letter.

SESSION 8: INSERT GRAPHICAL OBJE AND ILLUSTRATIONS

Most Word processors has supr{t)dr inserting illustrations in the form of Clip Arts, Shapes,

pictures, charts, etc.

KX

Clip Art: Clip Art can help in making a document look colourful and presentable. Clip arts are pre-
defined images available for use in documents. For example, if you would like to create a greeting
card for your friend, you can use clip arts such as balloon, flowers, etc. along with text message.
You can use the clip art gallery built-in within the word processor; you can also download clipart
from websites. Some of the websites that have free clip arts are:

* www.openclipart.org

» www.pdclipart.org

Steps to insert a clip art in a document,

1. Click on the Insert tab on the Ribbon.

2. Click on the option Clip Art in the Illustrations group

3. The Clip Art Task Pane appears. Enter the clipart category name in the search box and Click

Go.

4. Select the clipart that you want to use, double-click on it and it will be inserted into your

document

Steps to insert a clip art in a document from websites



http://www.pdclipart.org/

Sometimes, you may need clip arts that may not be available within the word processor
application. In such cases, you can visit websites that offer clip arts such as OpenClipart.org.

To download a clip art from www.openclipart.org,

1. Open the web browser, Type www.openclipart.org in the address bar and press Enter

You can use the search box available on the website for viewing the list of clip arts to suit your
needs.

Now you can select the clip art you like, download it to your computer and insert it using the photo
option in the word processor.

SESSION 9: TEXT WRAPPING

Text Wrapping enables you to surround a picture with text. The text wraps around the graphic or a picture.

Steps to insert Text Wrapping
1. Insert the picture / graphic / clipart in the document.
2. Click on the wrap text option under Text section of the Insert tab after double clicking on the picture.
3. Alternatively, select the picture then select the Text Wrapping dropdown arrow in the
Arrange group under the Format tab.
N\

Different Wrap Text Options A
The different wrap text options available in word processin ‘s@ftware are:-
1. Square <'i/
2. Tight \
3. Through Ny

”
(e

SESSION 10: INSERTING OBJECTS R D~
In addition to graphic images, to add a pgtéa’ﬁ'al touch to a special message or to illustrate a
special feature, you may want to embed nd files or maybe even actual files from other software
applications in your document. For example, you can insert a PDF file or a spread sheet within

the word processor. <\/X\)~

Steps to insert an object,
1. SelectInsert Tab &\<

2. Click Object under Text section. A dialog box will be displayed

3. Select Create from File Tab

4. Click Browse and select a file such as a spread sheet or a PDF document that is available
on your computer, Click Open and Click OK

Note: If you would like to edit the embedded document, double-click on it. It will automatically
open it for editing using respective application.
Demerits of embedding an object
1. The embedded objects cannot be printed.
2. The person opening your document must have the relevant software loaded on their
computer to operate the embedded file.
3. If you embed an object, the size of your document increases significantly and this may
cause problems in emailing the document as an attachment.
4. If you link an object, the person opening that document must have a direct connection to
the original file location of the object.

SESSION 11: INSERT SHAPES, SYMBOLS AND SPECIAL CHARACTERS




We can insert objects that have different shapes such as lines, basic geometric shapes, arrows,
Equations, shapes, flowchart shapes, stars, banners, and callouts using the shape option.

Steps to Insert ShapesClick on the Insert tab on the Ribbon.
1. Click on the option Shapes in the Illustrations group
2. Once you click the Shapes option a dropdown list with pre-defined shape such as box,
circle, etc. appears.
3. You can select the shape from the list of shapes available and draw the shape by dragging
the mouse with the left button clicked

Steps to Insert Symbols and Special Characters
1. Click on the Insert tab on the Ribbon.
2. Click on the option Symbol in the Symbols group
3. Adropdown list appears
4. Select a symbol from the list and double-click on to insert the symbol into the document

Note: If you would like to view more symbols and special characters for inserting into a document,
click on the More Symbols... option in the Symbols Dropdown list.

N\

N N7
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Unit 2 - Web Applications (Basics)

Session 1 - WORKING WITH ACCESSIBILITY OPTIONS

. The option in Microsoft Windows XP used for helping users with physical
disabilities and to reduce repetitive strain is Accessibility option.

. Sound Sentry is designed to help users with auditory impairments.

. The High Contrast option in Microsoft Windows XP is designhed to assist
people with vision impairments.

. Serial Keys is designed to assist people that have difficulty using a
keyboard or a mouse.

Session 1 - NETWORKING FUNDAMENTALS

. The acronym for LAN is Local Area Network.

. Three types of Wired Internet Connectivity are Dial-Up, DSL & Cable
Internet Access.

. Three types of Wireless Internet Connectivity are 3G, WIMAX & Wi-Fi.

Q1 - What is the definition of networking?

Answer - A computer network is a collection of computers and other
hardware components interconnected by communication channels (cables
or satellites) that allow sharing of resources and information.

Q2 - What are the advantages of networking?

Answer - Some of the advantages associated with networking are:

Data Sharing: One of the most important uses of networking is to allow
the sharing of data. Users can send text files, spread sheets,
documents, presentations, audio files, video files, etc. to other
users.

Hardware Sharing: Hardware components such as printers, scanners, etc.
can also be shared. For example, instead of purchasing 10 printers for
each user, one printer can be purchased and shared among multiple
users thus saving cost.

Internet Access Sharing: You can purchase a single Internet connection
and share it among other computers in a network instead of purchasing
multiple Internet connection for each computer. This is very commonly
found in Internet café (browsing centres), schools, colleges,
companies, etc.

Usage of network based applications: Such as web browsers, email
clients, chat application, audio & video calling, etc. is another
advantage.

Q3 - What are the different types of networking?

Answer - There are two major types of network Local Area Network (LAN)
and Wide Area Network (WAN).

Local Area Network

A local area network (LAN) is one which connects computers and devices
in a limited geographical area such as home, school, computer
laboratory, office building, or closely positioned group of buildings.
Usually local area networks offer very high speeds and are used for
connecting computers and peripherals such as printers, scanners, etc.
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Wide Area Network

A wide area network (WAN) is one which covers a broad area (i.e., any
network that links across metropolitan, regional, or national
boundaries). The Internet is the most popular WAN, and is used by
businesses, governments, non-profit organizations, individual
consumers, artists, entertainers, and many others.

Q4 - Explain LAN and WAN.

Answer -

Local Area Network

A local area network (LAN) is one which connects computers and devices
in a limited geographical area such as home, school, computer
laboratory, office building, or closely positioned group of buildings.
Usually local area networks offer very high speeds and are used for
connecting computers and peripherals such as printers, scanners, etc.

Wide Area Network

A wide area network (WAN) is one which covers a broad area (i.e., any
network that links across metropolitan, regional, or national
boundaries). The Internet is the most popular WAN, and is used by
businesses, governments, non-profit organizations, individual
consumers, artists, entertainers, and many others.

Session 3 - INTRODUCTION TO INSTANT MESSAGING

. Instant messaging (IM) is a form of communication over the Internet

that offers an instantaneous transmission of text-based messages from
sender to receiver.

. Microphones, Headsets, Speakers & Web Camera are required for audio and

video conferencing.

Q1 - List any five application based instant messaging software.
Answer - Application based instant messaging software is downloaded
and installed on user’s computer. Some of the popular instant
messaging software are:

. Google Talk

. Yahoo! Messenger

. Skype

. Windows Live Messenger
. Rediff Bol

Q2 - What do you mean by instant messages?

Answer - Instant messaging (IM) is a form of communication over the
Internet that offers an instantaneous transmission of text-based
messages from sender to receiver.

Most instant messaging software include the option for performing file
transfers, audio chat, video calling and conferencing,

sharing desktops, etc. apart from standard text chat.

Instant messaging software is widely used for personal and commercial
use.



Session 4 - CHATTING WITH A CONTACT - GOOGLE TALK

Q1 - State any 03 rules and etiquettes to be followed while chatting
on the Internet.

Answer - There are some general rules and etiquettes to be followed
while chatting. They are almost the same as those that apply for
emails.

1. Messages should be short and to the point.

2. Always introduce yourself by name if your screen name doesn’t reflect
it.

3. Always ask if the other person has time to chat first - regardless of
how important you think what you have to say is, it’s not going to be
well received if the recipient is busy.

4. In a business environment, know exactly what you want to discuss.

5. Typing your messages in uppercase is extremely rude - it’s considered
shouting and very aggressive.

6. Give people time to respond - Multiple questions sent to a recipient
before they’ve had a chance to answer can seem more like an
interrogation rather than a conversation.

7. Wherever possible, give the person you are communicating with your
undivided attention. It’s not just a sign of respect, but if you have
multiple conversations happening or are allowing other issues to
distract you, you may miss an important point in the other person’s
messages or lose the gist of the conversation.

8. It’s important to properly end an IM conversation - you may think the
chat is over, but the other person may not. While you’re off doing
other things, they may be sitting there staring at the screen waiting
for further communication from you!!

Q2 - What are the basic needs to use instant messaging (chat)
softwares.

Answer - Before, start using Yahoo! Messenger, a Yahoo Mail account is
required. If you don’t have a Yahoo! Mail Account already you can use
the built in option for creating a new Yahoo! Mail Account.

You should a 1list of contacts that are available for chat. If you
don’t have any contacts, you can add their Yahoo Mail account to your
contact list by sending an invite.

Session 5 - CREATING AND PUBLISHING WEB PAGES - BLOG

Q1 - Explain the purpose of a blog.

Answer - A blog is a discussion style site used by non-technical (or
technical users) users for creating personal web pages.

Blogs are similar to an online personal diary and simple to use.

We can use a blog to convey messages about events, announcements,
news, reviews, etc. Blogs are usually managed using a web browser and
this requires active internet connection.

Q2 - List any 5 websites that provide blog service.
Answer - There are hundreds of websites that offer blog service for
free. Some of the popular blogs include:

1. www.WordPress.com
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. www.blogger.com
. www.blog.com

. Wwww.weebly.com

. www.blogsome.com

Q3 - Difference between web page and website.

Answer - Web page and Website are relevant but distinct words.

A web page can be considered as a single entity whereas a website is a
combination of web pages. Web pages are accessed through a browser
while in website HTTP, and DNS protocols are used to access it.

Session 6 - USING OFFLINE BLOG EDITORS

Q1 - Explain the purpose of an offline blog editor.

Answer - If we do not have an active internet connection, we can
create blogs using a blog application and publish the blog whenever
internet connectivity is available.

Q2 - List any five offline blog editors.
Answer - There are several free offline blog editors available that
can be downloaded and installed on the local computer such as

. Qumana

. Windows Live Writer
. Blogdesk

. Marskdit

. BlogJet

. Blogo

Session 7 - ONLINE TRANSACTION

Q1 - Explain the purpose of online transactions.

Answer - Online shopping is a form of electronic commerce where
customers can buy or sell goods over the Internet. Customers need to
have an active internet connection for viewing goods or services
offered by a seller.

Customers can pay online using a credit, debit card or by internet
banking.

Online shopping could be useful in situations when:

e A customer does not have sufficient time to visit stores.

e Visiting a store is more expensive than purchasing a product online.
e A product or service that is not available in the local market is
available online.

Q2 - List any five websites that allow online transactions.

Answer - Some of the popular online transaction websites are:

. IRCTC, an online portal for booking flight and train tickets.

. Flipkart, an online shopping portal for buying consumer products.
. EBay, an online portal for buying and selling goods.

. Redbus, an online portal for booking bus tickets.

. Paytm, an online portal for recharge and paying bills.

Q3 - List any three payment tools to use online transactions.
Answer - To perform an online transaction, all you need is a web
browser and an active internet connection.
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In some cases where purchasing is involved, you will need a valid
credit card, debit card or online banking support referred to as Net
Banking Subscription. Some websites even allow COD (Cash on delivery)
where the users can pay once they receive the product or service.

Session 8 - INTERNET SECURITY

Q1 - Explain the purpose of Internet Security.

Answer - Internet security is a branch of computer security
specifically related to the Internet, often involving browser security
but also network security. Its objective is to establish rules and
measures to use against attacks over the Internet. The Internet
represents an insecure channel for exchanging information leading to a
high risk of intrusion or fraud, such as phishing.

Q2 - Explain different kinds of online threats.

Answer - Online threats such as Phishing, email spoofing, chat
spoofing, etc. can increase the chances of users getting compromised.
Spread sheet

UNIT-11] A

WORD PROCE%QﬁL
‘s\

Write about Font Face? [V

Ans:Font Face: After selecting the text you nee fe«cllck Font Name in the Font group to select
the particular font style from the fonts listed. _

Write about Font Size? *

Ans:Font Size: After selecting the text y .need to click Font Size in the Font group to select the
particular font size from the values glvé\%

Write about Grow Font?
Ans: After selecting the text y\(gﬁeed to click the icon in the Font group to make the
font size larger than the curre& nt size by the specified point.

Write about Shrink Font?

Ans: Shrink Font: After selecting the text you need to click the icon in the Font group to make
the font size smaller than the current font size by the specified point.

Write about Strike through?

Ans: Strikethrough: After selecting the text you need to click the icon in the Font group to make
a strike through the middle of the selected text.

Write about Subscript & Superscript?

Ans: Subscript: After selecting the text you need to click the icon in the Font group to make the
selected text lower than the normal text position.

Superscript: After selecting the text you need to click the icon in the Font group to make the
selected text higher than the normal text position.

Write about Clear Formatting? Ans: Clear Formatting is used to clear the character formatting
(such as Bold,Italics ,Underline, font face & size, superscript & subscript etc.) of the selected
text. To remove the character formatting, select the text and click on icon in the Font group.
Write about Text Highlight Color?

Ans:Text Highlight Color: Use this option to change the background color. To do so, select the
text and click on icon in the Font group. You can choose the background color by clicking on the
down arrow on the icon.
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How to change the Font color?

Ans: Font Color: Use this option to change the color of the text. To do so, select the text and
click on icon in the Font group. You can choose the text color by clicking on the down arrow on
the icon.

Write about change Case in word Document?

Ans: Change Case: Word processor helps us to change the text case to capital letters or small
letters.

You can also capitalize each word in the sentence and capitalize the starting word of the sentence
using Change Case under Font Group. To do so, after selecting the text you need to click the icon
in the Font group

Sentence Case: On selecting this option from the dropdown list, the first character in the first
word of the selected sentence will be converted to Capital Letter (Uppercase).

Lowercase: On selecting this option from the dropdown list, the selected text will be converted to
Small Letters (lowercase).

UPPERCASE: On selecting this option from the dropdown list, the selected text will be
converted to Capital Letters (UPPERCASE).

Capitalize Each Word: On selecting this option from the dropdown list, the first character in all
the words of the selected sentence will be converted to Capital Letter (Uppercase).tOGGLE
CASE: On selecting this option from the dropdown list, the small letters in the selected text will
be converted into capital letters and capital letters will be converzé\i nto small letters.

Fill in the blanks A\J

1. After selecting the text you need to click the Font size ir<t/ﬁ‘§‘lfont group to make the font size
larger than the current font size.

2. To remove the character formatting, select the texta@‘click on Clear Formatting in the Font
group. Ch e

3. On selecting Sentence Case, the first characterinthe first word of the selected

sentence will be converted to Capital Letter.q o~

4. On selecting Upper Case, the first chayagter in all the words of the selected

sentence will be converted to Capital L

SESSION 8: INSERT GRAPHICAL®BJ

Question and Answers: R

What is Clip Art?

Ans:Clip Art can help in making a document look colourful and presentable. Clip arts are pre-
defined images available for use in documents. For example, if you would like to create a
greeting card for your friend, you can use clip arts such as balloon, flowers, etc. along with text
message.

Give Some Websites name which provides free Clip arts?

Ans: Some of the websites that have free clip arts are:

* http://www.openclipart.org

* http://www.pdclipart.org

* http://www.clker.com

* http://www.freeclipartnow.com

* http://www.wpclipart.com

How to download a Clipart from the website?

Ans: To download a clip art from http://www.openclipart.org,

1. Open the web browser, Type http://www.openclipart.org in the address bar and press

Enter You can use the search box available on the website for viewing the list of clip arts to suit
your needs. For example, Type School Bag in the search box and Click Search. You will be
displayed with list of clip arts matching the keyword School bag, Now you can select the clip art
you like, download it to your computer and insert it using the photo option in the word
processor.

ECTS AND ILLUSTRATIONS


http://www.openclipart.org/
http://www.pdclipart.org/
http://www.clker.com/
http://www.freeclipartnow.com/
http://www.wpclipart.com/
http://www.openclipart.org/
http://www.openclipart.org/

7. What are Objects in a Word processing software?
8. Ans:.objects can be almost any form that can be generated as a computer file. Sounds,
Music, drawings, documents spreadsheets, etc. are all examples of possible objects that you can
include
in a document, or link to a document.
Fill in the blanks:
1. Embedding an object makes it a part of the document while linking an object does not include
the object file into the document files.
2. Readers trying to access the linked object must also have direct access to the separate file that
forms that object.
3. Clip Art can help in making a document look colorful and Presentable.
4. Clip Art is available under inserting Illustrations group in Insert Tab
SESSION 9: TEXT WRAPPING
Fill in the blanks:
1. T o search for a picture, place the cursor before the text, click Insert Tab, and
click Picture under Illustrations.
2. After you have inserted the picture, you can wrap the text by using the Wrap Text option.
Answer the following:
1. List any three word wrapping options available in a word proce ing software.
Ans: The three word wrapping options available in a word proc g software are:
tight, square and through. \/
2. List word wrapping options available ina word process(/\gaftware

Ans: The following are the word wrapping options:’av*éﬁfable in word processing software:

4
e Inline with text « ON

e Square »{““\Y

. Tight oS

e Through {»\?\

o Top and Bottom ‘<\/

e Behind the text

e Infront of text &

Session 10: Inserting Objects

Fill in the blanks:

1. To open an embedded document, double Click on it.

2. Embedded objects cannot be printed.

3. When you embed objects in a document, you may have trouble emailing
it because the size of the document increases significantly.

Question and answers:

1. How to insert objects in word document?
Ans: To insert an object,
e Open a new word document
e Select Insert Tab
e Click Object under Text section. A dialog box will be displayed.

e Select Create from File Tab
e Click Browse and select a file such as a spread sheet or a PDF document that is



available on your computer, Click Open and Click OK
¢ Notice the document is available embedded within your word document.

Note: If you would like to edit the embedded document, double-click on it. It will
automatically open it for editing using respective application.

2. Mention Key points to embedded object in word document?

Ans:1. The embedded objects cannot be printed.

2. The person opening your document must have the relevant software loaded on
their computer to operate the embedded file.

3. If you embed an object, the size of your document increases significantly and this
may cause problems in emailing the document as an attachment.

4. If you link an object, the person opening that document must have a direct
connection to the original file location of the object.

SESSION 11: INSERT SHAPES, SYMBOLS AND SPECIAL
CHARACTERS M

- - & \\o 4
Fill in the blanks: Nl
1. You can insert lines, basic geometric shapes, arrows, e @%ﬁ shapes,
flowchart shapes, stars, banners, and callouts using thg &@

option. \

2. Symbol option is available under Symbols groupin the Insert
tab. g@

Question and answers: - ¥

. - A
How to insert Shapes in word Processing.seftware?
Ans: To work with shapes, open a ne,yy%’ocument in word processor,

1. Click on the Insert tab on the Ribban.
2. Click on the option Shapes ig%ﬁixlllustrations group, as shown in figure 24.
3. Once you click the Shape&ﬁp ion a dropdown list with pre-defined shape such
as box, circle, etc. appears.
4. You can select the shape from the list of shapes available and draw the shape
by dragging the mouse with the left button clicked. For example, if would like
to insert a square, select the box shaped item from the list, click and drag the
shape to draw a square.
How to insert Special characters or Symbols in word document?
Ans:To work with symbols or special characters, open a new document in word processor.
1. Click on the Insert tab on the Ribbon.
2. Click on the option Symbol in the Symbols group
3. A dropdown list appears, Select a symbol from the list and double-click on to insert the
symbol into the document.
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« Current

- Potential Difference
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« Ohm's Law

- Mathematical expression for Ohm's law
- V-1 graph for Ohm's law

- Resistance

- Ohm

- Rheostat

« Factors on which the Resistance of o
conductor depends

- Resistivity

» Resistors in Series

_, Total/resultant/overall/effective
resistance In series

- Voltage across each resistor
 Resistors in parallel



- Advantage of parallel combination over
series combination

« Heating effect of electric circuit

- Joule's law Heating effect of electric
current

- Filament of electric bulb is made up of
tungsten

- Electric Fuse
- Electric Power

Introduction

- Charge is a fundamental particle in an
atom. It may be positive or negative.

- Like charges repel each other.
- Unlike charges attract each other.
-~ Coulomb (C) :S. L unit of charge

-~ 1 Coulomb charge = Charge present on

approx. 6 x 1018 electrons



- Charge on1electron = Negative charge

of 1.6 x1071° C

L.e.Q=ne

Where, Q = Charge (total)
N = No. of electrons

e = Charge on1electron

Current

» Current (1): The rate of flow of charge is
called current.

Current = Charge/Time = |=Q/T



S.I. unit of current = Ampere (A)
5 1A=1Cs’!

S5 1TMA=10"3 A

S5 TMA=10°A

-~ Current is measured by Ammeter. Its
symbol is

___+A_:__

-~ AMmmeter has low resistance and
always connected In series.



- Direction of current is taken opposite to
flow of electrons as electrons were not
Known at the time when the phenomenon
of electricity was discovered first and

current was considered to be flow of
positive charge.

Potential Difference

« Potential Difference (V): Work done to

move a unit charge from one point to
another.

V=W/Q

1 Volt: When 1joule work is done in

carrying one Coulomb charge then
potential difference is called 1 volt.

- S. . unit of Potential difference = Volt (V)
1v=1JC™!



e 1Volt: When 1 joule work is done In
carrying one Coulomb charge then
potential difference is called 1 volt.

V=W/Q

e Voltmeter: It is an instrument to
measure the potential difference.
- It has high resistance and always

connected In parallel. Symlbol is
WU ;.7 Vy—

- Cell Is the simplest device to maintain
potential difference.

- Current always flow from higher
potential to lower potential.



Symbols of Some Commonly Used
Components in Circuit

Components Symbols
No

| An electric cell —' —
2 A battery or a combination ol cells —'l I—l |—| —

3  PMug key or switch (open) —( )—

4  Plug key or switch [closed) —(i)—

5 A wire joint |

6  Wires crossing without joining %

7 Electric bulb M« .9
8 A resistor of resistance R e \NNN e

9  Variable resistance or rheostal _M\A__m n , } A A

10 Ammeter

11 Voltmeter



Ohm’s Law

Potential difference across the two points
of a metallic conductor is directly
proportional to current passing through
the circuit provided that temperature
remains constant.

» Mathematical expression for Ohm's law
V |
- V=IR

- Ris a constant called resistance for
given metal.



 V-1graph for Ohm’s law
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e Resistance (R): It is the property of a

conductor to resist the flow of charges
through it.



« Ohm (Q): S.I. unit of resistance.

» 1ohm =1volt/lampere



-~ When potential difference is 1V and
current through the circuit is 1A, then
resistance is 1 ohm.

 Rheostat: Variable resistance is o
component used to regulate current
without changing the source of voltage.

Factors on which the Resistance of a
Conductor depends

e Resistance of a uniform metallic
conductor Is:

(i) directly proportional to the length of
conductor,

(ii) inversely proportional to the area of
cross-section,

(iii) directly proportional to the
temperature and

(iv) depend on nature of material.



e Resistivity (P): It is defined as the
resistance offered by a cube of a material
of side Im when current flows
perpendicular to its opposite faces.

. Its S.I. unit is onm-metre (QmM).

- Resistivity does not change with
change in length or area of cross-section
but it changes with change in
temperature.

- Range of resistivity of metals and alloys

is10°®to10°° om.

_. Range of resistivity of insulators is 10" to

10 am.

- Resistivity of alloy is generally higher
than that of its constituent metails.

- Alloys do not oxidize (burn) readily at
high temperature, so they are commonly
used In electrical heating devices.



- Resistivity of alloy is generally higher
than that of its constituent metails.

- Alloys do not oxidize (burn) readily at
high temperature, so they are commonly
used In electrical heating devices.

- Copper and aluminium are used for

electrical transmission lines as they have
low

resistivity.



Resistors in Series

- When two or more resistors are
connected end to end, the arrangement is

called series

combination.

o R R, R

THHH ——

Total/resultant/overall/effective
resistance in series

Re =Ry+ Ry + R3
- Current through each resistor is same.

-~ Equivalent resistance is larger than the
largest individual resistance.



« Voltage across each resistor

e Vp = IR
+ Vo= IRy [Vy+ Vo + V3 =V]
+V3=IR3V =R

- V=IRy+ IRy +IR3
« IR =I(Ry+ R, + R3)
«R=Rj+ Ro+R3

Resistors in Parallel
K,

+-

1H HH F———o——();

- Voltage across each resistor is same
and equal to the applied voltage.



- Total current is equal to sum of currents
through the individual reistances.
el=h+lr+ 13

> VIR=V/Ri+ V/Ry + V/R3



- Reciprocal of equivalent resistance is
equal to sum of reciprocals of individual
resistances.

I/Rp=1Ri+1/Ra+1/R3

-~ Equivalent resistance is less than the
value of the smallest individuadl resistance
INn the combination.

Advantages of Parallel Combination over
Series Combination

(i) In series circuit, when one component
fails, the circuit is broken and none of the
component works.

(i) Different appliances have different
requirement of current. This cannot be
satisfied In series ds current remains
same.

(iii) The total resistance in a parallel circuit
IS decreased.



Heating Effect of Electric Circuit

- |If an electric circuit Is purely resistive,
the source of energy continually get
dissipated entirely in form of heat. This Is
known as heating effect of electric
current.

As E = PxT « VIt {E=H]
Heat produced, H = VIt {V = IR}

Or, Heat produced, H = IRt

Joule’s Law of Heating Effect of Electric
Current

- |t states that the heat produced in a
resistor is (i) directly proportional to

square of current, H « |2

- Itis directly proportional to resistance
for a given current, H « R

- Itis directly proportional to time for
which current flows through the
conductor H « t.



So. H = I?Rt

-~ Heating effect is desirable in devices
like electric heater, electric iron, electric
bulb, electric fuse, etc.

-~ Heating effect is undesirable in devices
like computers, computer monitors (CRT)
TV, refrigerators etc.

- In electric bulb, most of the power
consumed by the filament appears a heat
and a small part of it is radiated in form of
light.

* Filament of electric bulb is made up of
tungsten because:

(i) it does not oxidise readily at high
temperature.
(i) it has high melting point (3380° C).



-~ The bullbs are filled with chemically
Inactive gases like nitrogen and argon to
prolong the life of filament.

* Electric Fuse: It is a safety device that
protects our electrical appliances In case
of short circuit or overloading.

-~ Fuse is made up of pure tin or alloy of
copper and tin.

- Fuse Is always connected In series with
live wire.

-~ Fuse has low melting point.

-~ Current capacity of fuse is slightly
higher than that of the appliance.



e Electric Power: The rate at which electric
energy Is consumed or dissipated in an
electric circulit.

P=V]
-~ P=12R=V?/R

S.1. unit of power = Watt (W)
> 1 Watt =1volt x1ampere

-~ Commercial unit of electric energy =
Kilo Watt hour (KWh)

~ 1KWh = 3.6 x10° J
- 1KWh =1unit of electric energy



DR. NIDHI SEHGAL

LIFE PROCESSES

DAY-1 ACTIVITY

What you'll need:

TEXT BOOK NCERT (SCIENCE),

NOTE BOOK (SCIENCE),

What you'll do:

First read and understand the notes/NCERT (SCIENCE), then try to solve the given assignments
(in NOTE BOOK -SCIENCE), and scale your preparedness for your PA_1 examination.

INTRODUCTION

Life
e Life is the property that distinguishes living beings from the non living objects.
e All living organisms have some fundamental characteristics that make them different from the
non living matters These fundamental characteristics are:
Presence of protoplasm
1. Cellular organization
Nutrition
Metabolism
Growth
Reproduction....etc
Earth happens to be the only known planet having a life. There are beings who live, die and
become part of nature again.

s U A wWN

Life Process
e Maintenance of living organism is essential even if they are moving, resting or even sleeping.
e The processes which together perform the function of maintenance of ‘life’ are called as life
processes.
e Nutrition, respiration, circulation, excretion are examples of essential life processes.
e In unicellular organisms, all these processes are carried out by that single cell.
e In multicellular organisms, well-developed systems are present to carry out the processes.

Nutrition

The process of acquiring food that is needed for nourishment and sustenance of the organism is
called nutrition.
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« Nutrition: The process by which an organism takes food and utilizes it, is called nutrition.

« Need for Nutrition: Organisms need the energy to perfarm various activities. The energy is supplied by
the nutrients. Organisms need various raw materials for growth and repair. These raw materials are
provided by nutrients.

+ Nutrients: Materials which provide nutrition to organisms are called nutrients. Carbohydrates, proteins
and fats are the main nutrients and are called macronutrients. Minerals and vitamins are required in
small amounts and hence are called micronutrients.

¢ There are two main modes of nutrition, autotrophic and heterotrophic.
¢ Heterotrophic nutrition has subtypes as holozoic, saprophytic and parasitic nutrition.

« Modes of Nutrition
1. Autotrophic Nutrition.
2. Heterotrophic Nutrition.

Autotrophic Nutrition — Life Processes Class 10 Notes

The mode of nutrition in which an organism prepares its own food is called autotrophic nutrition. Green
plants and blue-green algae follow the autotrophic mode of nutrition.

» The organisms which carry out autotrophic nutrition are called autotrophs (green plants).

Autotrophs —2*5 Simple inorganic —C-i::%v Complex high energy

matenal molecules of carbohvdrates

» Autotrophic nutrition is fulfilled by the process, by which autotrophs intake CO; and H»0, and convert
these into carbohydrates in the presence of chlorophyll, sunlight is called photosynthesis.

» Equation
Sun's Energy

COy + HYO —=> C(H1,0O4 + Oy

Carbon Wat O S

dioxide o .. VORI Ry
..

Chlorophyill
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Photosynthesis: The process by which green plants prepare food is called photosynthesis.

= During this process, the solar energy is converted into chemical energy and carbohydrates are
formed.

e Green leaves are the main site of photosynthesis.

« The green portion of the plant contains a pigment chloroplast, chloraphyll (green pigment).

« The whole process of photosynthesis can be shown by the following equation:

Sunlight
+ ST H,.O_ + 60_ +6H,0
6C02 e Chilorophyll CsM129% 2 2
Carbon Water Glucose Oxygen  Water

dioxide

Raw Materials for Photosynthesis:

« Sunlight

« Chlorophyll: Sunlight absorbed by chloroplast

» COs: Enters through stomata, and oxygen (05) is released as a byproduct through stomata on the leaf.

« Water: Water + dissolved minerals like nitrogen, phosphorous etc., are taken up by the roots from the
soil.

How do raw materials for photosynthesis become available to the plant?

» Water comes from the soil, through the xylem tissue in roots and stems.
= Carbon dioxide comes in the leaves through stomata.

Site of Photosynthesis: Chloroplast in the leaf. Chloroplast contains chlorophyll (green pigment)
Main Events of Photosynthesis:

« Absorption of light energy by chlorophyll.

= Conversion of light energy into chemical energy + splitting (breaking) of water into hydrogen and
oxygen.

= Reducticn of CO5; to carbohydrates.

= Sunlight activates chlorophyll, which leads to splitting of the water molecule.

= The hydrogen, released by the splitting of a water molecule is utilized for the reduction of carbon
dioxide to produce carbohydrates.

= Oxygen is the by-product of photosynthesis.

= Carbohydrate is subseqguently converted into starch and is stored in leaves and other storage parts.

= The splitting of water molecules is a part of the light reaction.
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Stomata

Stomata are pores on the leaves that help in exchange of gases.
They are mostly found on the underside of the leaf.
Each stoma is guarded by guard cells, which control the opening and closing of the pore.

The water content of the guard cells is responsible for their function.

Nucleus

Chloroplasts !
Vacuole

Guard Cell

Cell Wall

(a) Stoma Closed ' (b) Stoma Open

Heterotrophic Nutrition - Life Processes Class 10 Notes

The mode of nutrition in which an organism takes food from another organism is called heterotrophic
nutrition. Organisms, other than green plants and blue-green algae follow the heterotrophic mode of
nutrition. Heterotrophic nutrition can be further divided into three types, viz. saprophytic nutrition, holozoic
nutrition, and parasitic.

« Saprophytic Nutrition: In saprophytic nutrition, the organism secretes the digestive juices on the food.
The food is digested while it is still to be ingested. The digested food is then ingested by the organism.
All the decomposers follow saprophytic nutrition. Some insects, like houseflies, also follow this mode
of nutrition.

+ Holozoic Nutrition: In holozoic nutrition, the digestion happens inside the body of the organism. i.e.,
after the food is ingested. Most of the animals follow this mode of nutrition.

« Parasitic Nutrition: The organism which lives inside or outside another organism (host) and derives
nutrition from it is known as parasites and this type of mode of nutrition is called parasitic nutrition.
For example Cuscuta, tick etc.
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Try the following questions:

Question 1 What are nutrients?

Question 2 What is autotrophic nutrition?

Question 3 What is heterotrophic nutrition?

Question 4 Why are green plants called producers?

Question 5 What is photosynthesis?

Question 6 What are the raw materials required for photosynthesis?

Question 7 From where do the green plants get carbon dioxide?

Question 8 How do green plants get water?

Question 9 Why are minerals essential in photosynthesis?

Question 10 How do plants obtain minerals?

Question 11 How do the plants obtain carbon dioxide and water?

Question 12 Name the different types of heterotrophic nutrition?

Question 13 What is holozoic nutrition?

Question 14 What are saprotrophs?

Question 15 Name two parasitic plants?
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LIFE PROCESSES
DAY-2 ACTIVITY
What you'll need:
TEXT BOOK NCERT (SCIENCE),
NOTE BOOK (SCIENCE),
What you'll do:

First read and understand the notes/NCERT (SCIENCE), then try to solve the given
assignments (in NOTE BOOK -SCIENCE), and scale your preparedness for your PA_1
examination.

Nutrition in Amoeba

« Amoeba feeds by holozoic mode of nutrition.
. It engulfs the food particle using pseudopodia, the process is called phagocytosis.
. The engulfed food gets enclosed in a food vacuole.

. As the food vacuole passes through the cytoplasm, digestion, absorption and
assimilation take place.

« When the food vacuole opens to outside, egestion of undigested food takes place.

o) (2)
i ""-\-\_ -
t ' * 7 *
Nucleus —' Food particle !
Food particle Pseaudopodia Food vacule

)

_ -

I{?D Ingestion I(Zt] Digestion |@ Absorption |@ Assimilation l@ Egestion

Nutrition in Paramecium

« Paramecium also exhibits holozoic nutrition.

THE AARYANS
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. However, they have cilia that help them to engulf the food through the oral
groove.

. A food vacuole is created enclosing the food.

« It moves through the cytoplasm, the process is called cyclosis.

. Food digested in the food vacuole is absorbed by the cytoplasm.

. Undigested food is given out to a tiny pore called anal pore or cytopyge.

@ Peliicle @ Nucleus | @ Chioroplast | @ Flagellum
© Eyespot @ Contractile Vacuole

Try the following questions:
Question 1 What is the importance of nutrients?

Question 2 What are the steps involved in holozoic nutrition?
Question 3 How is food digested in amoeba?

Question 4 What are microphagous feeders?

Question 5 How does ingestion take place in paramecium?
Question 6 Explain the processes of nutrition in Amoeba
Question 7 Give one example of the following:

i) Autotroph, ii) Herbivore, iii) Carnivore, iv) Omnivore
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LIFE PROCESSES
DAY-3 ACTIVITY
What you'll need:
TEXT BOOK NCERT (SCIENCE),
NOTE BOOK (SCIENCE),
What you'll do:

First read and understand the notes/NCERT (SCIENCE), then try to solve the given assignments
(in NOTE BOOK -SCIENCE), and scale your preparedness for your PA_1 examination.

Holozoic Nutrition

The mode of nutrition in which animals take their food as a whole is
called as holozoic nutrition.

Nutrition in Humans

. Humans are omnivores, they can eat plant-based food as well as animal-based food.
. Being more complex, humans have a very complicated nutrition system.

. The digestive system has an alimentary canal and associated digestive glands, which
together function to nourish the body.

« There are five stages in human nutrition; Ingestion, Digestion, Absorption, Assimilation
and Egestion.

- Four stages i.e. ingestion, digestion, absorption and egestion take place in the
alimentary canal while assimilation of food takes place in the whole body.

Alimentary Canal

. Alimentary canal in humans is a long tube of varying diameter.
. It starts with the mouth and ends with the anus.

. Oesophagus, stomach, small intestine and large intestine are the parts of the
alimentary canal.

Mouth

. lItis the opening of the alimentary canal and helps in ingestion of food.
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. The buccal cavity which is present behind the mouth is also commonly referred to as
the mouth.

« The buccal cavity has teeth and tongue.
. The set of teeth helps in the mastication of food.
. The tongue has taste buds on it and thus helps in tasting the food.

. The salivary glands open also in the buccal cavity and pour saliva which initiates the
process of digestion.

Teeth

. Teeth are the hard structures present in the buccal cavity.
« They help us to cut, shear and masticate the food we eat.

. Vertical section of a tooth shows four layers as enamel, dentine, cement and dental
pulp.

. Enamel is outermost, shiny, highly mineralized and hardest part of the human body.

« Dentine makes the bulk of the tooth and contains 70% inorganic salts.

. Cement is present at the lining of a tooth and bony socket.

. The dental pulp is the central soft part of a tooth and contains nerve endings, blood
and lymph vessels along with connective tissue.

. There are four types of teeth in humans, Incisors, canines, molars and premolars,
each with a specific function.

- Incisors cut the food, canines tear the food while molars and premolars crush it.
. The dental formula in adult humans is 2:1:2:3.
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Salivary Glands

Salivary glands are the exocrine glands that secrete saliva and through a system of
ducts, it is poured into the mouth.

In humans, three major pairs of salivary glands are present, parotid, submandibular
and sublingual.

In healthy individuals between 0.5 to 1.5 litres of saliva is produced per day.
Saliva serves the following functions in the oral cavity.

1. It lubricates and protects the soft and hard tissues of the oral cavity
2. It also gives protection from dental caries
3. Saliva prevents microbial growth in the oral cavity.
4. Saliva can encourage soft tissue repair by decreasing clotting time and increasing
wound contraction
5. Saliva contains the enzyme amylase that hydrolyses starch into maltose and dextrin.
Hence saliva allows digestion to occur before the food reaches the stomach
6. Saliva acts as a solvent in which solid particles can dissolve in and enter the taste
buds located on the tongue.
Parotid salivary gland
Parotid duct
Sublingual
ducts
Sublingual salivary gland
Submandibular salivary gland
7 Submandibular duct
Oesophagus & Stomach
Oesophagus

The swallowed food passes into the oesophagus.
It is a muscular tube, about 25 cm long, with a sphincter (valve/opening) at each end.
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. lIts function is to transport food and fluid, after being swallowed, from the mouth to the
stomach.

« Food is pushed down by peristaltic movements.

Peristalsis

A constant wave-like movement of the alimentary canal right from the
oesophagus to the small intestine is called as peristalsis.

« Muscles present in the wall of the alimentary canal are responsible for peristalsis.
. This movement helps to push the food through the alimentary canal.

Stomach

. The stomach is a thick-walled bag-like structure.

« lIts receives food from the oesophagus at one end and opens into the small intestine at
the other end.

. The inner lining of the stomach secretes mucous, hydrochloric acid and digestive
juices.

. Food is churned into a semi-solid mass in the stomach and is called chyme.

« Enzymes present in the gastric juice break down the food.

« Hydrochloric acid helps in partial digestion of proteins and also kills harmful bacteria.
« Mucus secreted by the wall of the stomach resists the action of HCI on itself.

Small Intestine

. The small intestine is the longest part of the alimentary canal, about 20 feet long in
humans.

« It has regions, duodenum, the region which follows stomach, jejunum is the middle
part and ileum is the later region which continues further into the large intestine.

. The internal surface of the small intestine is folded into finger-like projections called
villi.

« A common pancreatic duct from pancreas and liver opens into the duodenum.

. Most of the chemical digestion and absorption takes place in the small intestine.
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Large Intestine

. The large intestine in humans is about 5 feet long.
« It has two regions, colon ( about 1.5 m) and rectum (10 cm in length in the adult).

« The region of large intestine after ileum is called colon while the last part is called the
rectum.

. Colon has three regions as, ascending colon, transverse colon and descending colon.

. At the base of the ascending colon, a small finger-like out-growth is seen and is
called an appendix.

. It houses many useful bacteria required for digestion of food.
« Rectum opens to outside by anus.
« The anus has internal and external anal sphincters.

. -
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Large intestine

Small intestine

Digestive Glands

. Several glands produce digestive juices that help in digestion of the food.
. Salivary glands, Gastric glands, Liver, Gallbladder, Pancreas are few to name.
. Salivary glands secrete saliva which initiates digestion in the mouth itself.

. Gastric glands present in the wall of the stomach secrete hydrochloric acid and
enzyme pepsin.

. The liver secretes bile which is stored in the gallbladder. Bile helps in digestion of fats.

« The pancreas secretes many digestive enzymes and its secretion is called as
pancreatic juice.

« Enzymes like trypsin, chymotrypsin, lipase, amylase are present in the pancreatic
juice.
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Gallbladder

Pancreas

. The pancreas is a long, flat gland present behind the stomach in humans.

. Itis one of the major digestive glands and is of mixed nature i.e. endocrine
as well as exocrine.

. As an endocrine organ, it secretes two hormones called insulin and
glucagon which maintain the blood sugar level.

. As an exocrine gland, it secretes pancreatic juice which is nothing but a
mixture of many digestive enzymes.

. The digestive enzymes secreted by the pancreas include trypsin and
chymotrypsin and proteases which digest proteins.

Liver

. The liver is the largest and major digestive gland of humans

. Liver, in humans, is located in the upper right-hand portion of the abdomen.
« This organ is dark reddish-brown in colour due to an extensive blood supply.
. Some of the important functions of the liver are as follows:

1. It secretes bile that helps in digestion.

2. It filters the blood coming from the digestive tract before passing it to the rest of the
body.

3. It detoxifies various metabolites and drugs

4. The liver makes proteins important for blood clotting and other functions.
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5. It stores and releases glucose as needed.
6. It processes haemoglobin, from the dead and worn out RBCs, for the iron content (the

liver stores iron).

7. Conversion of harmful ammonia to urea takes place in the liver.

Digestive Juices

Pancreatic juice, bile and intestinal juice (succus entericus) are collectively called as
digestive juices.

A common duct from digestive glands pours the secretions into the duodenum.

Chyme enters into the small intestine where complete digestion takes place due to the
action of various enzymes.

In the duodenum, the acidity of chyme is turned to alkalinity by the action of bile
coming from the liver. This is necessary for pancreatic enzyme action.

Bile also emulsifies the fats into smaller globules.
Pancreatic and intestinal amylases break down the carbohydrates into glucose.

Trypsin and chymotrypsin are the proteases responsible for the breakdown of proteins
finally into amino acids.

Lipase is the enzyme which acts on the emulsified fats and breaks them down into
glycerol and fatty acids.

Physiology of Digestion

Mechanical digestion of food takes place in the buccal cavity where teeth masticate
the food, saliva gets mixed and it turns into a bolus.

Digestion of starch starts in the buccal cavity itself, with the action of salivary amylase
present in the saliva.

Salivary amylase converts starch into maltose.

In the stomach, the churning of food takes place due to the muscular contraction and
relaxation of its wall. It breaks down the food into simpler substances.

Digestion of proteins starts in the stomach with the action of pepsin. Proteins are
broken down into smaller fragments called peptide by the action of pepsin.

The bolus after mixing with gastric juice, turn into a fine soluble form known as the
chyme.

Chyme enters into the small intestine where complete digestion takes place due to the
action of various enzymes present in the pancreatic juice, bile and intestinal juice.
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The digested food is completely absorbed by the villi and microvilli of the small
intestine.

Undigested food then enters into the large intestine.

The colon is responsible for absorption of water and salts whereas rectum stores the
undigested food temporarily before defaecation.

Anatomy of Digestive Tract

The alimentary canal in humans is approximately 30 feet (9m) long.
It starts with the mouth and ends in the anus.
Between these two openings, the alimentary canal is the tube of varying diameter.

Oesophagus, stomach, small intestine (divided into three regions as duodenum,
jejunum and ileum) and large intestine(having two regions as colon and rectum) are
the parts of the alimentary canal.

Salivary glands, pancreas and liver act as major digestive glands.

Glands present in the wall of the stomach and small intestine also contribute towards
digestion of food.

Role of HCI

Hydrochloric acid in the stomach is secreted by the gastric glands present in its wall.
pH of the gastric acid is usually between 1.5 to 3.5
This acid serves the following functions:

. Converts inactive pepsinogen and pro-rennin into active pepsin and rennin

respectively.

Provides acidic medium for protein digestion.

Kills bacteria entered through food and prevents infection.
Prevents putrefaction of food in the stomach.

A thick layer of mucus secreted by the mucous glands of the stomach prevent itself
from the action of the gastric acid.

Excess acid damages gastric mucosa and causes gastric and duodenal ulcers.
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Heterotrophic Nutrition

When an organism depends on others for food, such a mode of nutrition
is called as a heterotrophic mode of nutrition.

. These organisms depend on autotrophs for their nutritional requirements.

. E.g. Animals which eat plants as their food are called herbivores.

. Animals which eat other animals as their food are called carnivores.

. Holozoic, saprophytic and parasitic nutrition are all types of heterotrophic nutrition.

Glandular Epithelium

. Many small glands present in the inner layer of the stomach and intestine take part in
the digestion of food.

« These glands are present in the epithelial lining of the stomach and intestine.
. The glands present in different regions of the stomach are called gastric glands.

. They are responsible for the secretion of mucus, hydrochloric acid and enzymes like
pepsinogen.

. The glands present in the epithelial lining of the small intestine and large intestine are
called intestinal glands.

. Glands of the small intestine are responsible for the secretion of intestinal juice also
called succus entericus.

« Intestinal juice contains hormones, digestive enzymes, alkaline mucus, substances to
neutralize hydrochloric acid coming from the stomach.

 Intestinal juice completes the digestion started by the pancreatic juice.
. Glands of the large intestine are associated with absorption of water and electrolytes.

Villi and Micro Villi

. Complete digestion and absorption of food take place in the small intestine.

« Pancreatic juice coming from the pancreas, bile from the liver and intestinal juice
secreted by the intestinal glands complete the digestion of food material.

. All the digested nutrients are absorbed by the long finger-like projections present in the
ileum of the small intestine.
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. These small finger-like projections of the inner wall of intestine are called as villi
(singular: villus).

. Each villus has its cell membrane of the lumen side again folded into microscopic
processes, called microvilli.

. Villiincrease the internal surface area of the intestinal walls making available a greater
surface area for absorption.

. Digested nutrients pass into the semipermeable villi through diffusion.
« Villi also help in chemical digestion of food by secreting digestive enzymes.

Water Absorption in Large Intestine

. The large intestine is not involved in the digestion of food or absorption of nutrients.

. The major function of the large intestine is to absorb water from the remaining
indigestible food matter and make the stool solid.

. The large intestine also helps in absorption of vitamins made by bacteria that normally
live in the large intestine.

. The innermost layer of the large intestine also acts as a barrier and protects from
microbial infections and invasions.

« Rectum stores the undigested food temporarily until defaecation.
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Try the following questions:
Question 1 Which enzyme is present in saliva?What is its
function?
Question 2 What is the function of epiglottis?
Question 3 What is the role of HCL in human stomach?
Question 4 What is the fuction of bile?
Question 5 What are the functions of Liver and the Pancreas?
Question 6 Name the main organs of digestive system of
grasshopper in the order in which they are involved in digesting

food.

Question 7 What is Holozoic mode of nutrition? Give two
examples

Question 8 Name the salivary glands present in human
mouth?

Question 9 What is the function of intestinal villi?

Question 10 Name the enzymes secreted by Liver and
Pancreas.
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LIFE PROCESSES
DAY-4 ACTIVITY
What you'll need:
TEXT BOOK NCERT (SCIENCE),
NOTE BOOK (SCIENCE),
What you'll do:

First read and understand the notes/NCERT (SCIENCE), then try to solve the given assignments
(in NOTE BOOK -SCIENCE), and scale your preparedness for your PA_1 examination.

RESPIRATION

Introduction to Respiration

. Respiration broadly means the exchange of gases.
. Animals and plants have different means of exchange of gases.

. At a cellular level, respiration means the burning of the food at the for
generating the energy needed for other life processes.

. Cellular respiration may take place in the presence or absence of
oxygen.

Glucose + Oxygen —— Energy + Carbon dioxide + Water

T {AF’ )
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Types of Respiration - Life Processes Class 10 Notes

+ Aerobic respiration: This type of respiration happens in the presence of oxygen. P
converted into carbon dioxide. Energy is released and water molecule is also formr
Drocess.

« Anaerobic respiration; This type of respiration happens in the absence of oxygen.
either converted into ethyl alcohol or lactic acid. Ethyl alcohol is usually formed in
respiration in microbes, like yeast or bacteria. Lactic acid is formed in some micro
muscle cells.

e Glucose (6 carbon molecule) — Pyruvate (3 carbon molecules) + Energy
o Pvruvate (Inveast. lack of O») — Ethvl alcohol + Carbon dioxide + Enerav

Respiration in Humans

. The human respiratory system is more complex and involves breathing,
exchange of gases and cellular respiration.

. A well defined respiratory system helps breathing and exchange of
gases.

. Breathing involves the inhalation of oxygen and exhalation of carbon
dioxide.

. The gaseous exchange takes place in the lungs and oxygen is supplied
to all cells of the body.

. Cellular respiration takes place in each and every cell.
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Respiratory System

. The human respiratory system involves the nose, nasal cavities,
pharynx, larynx, trachea/windpipe, bronchi, bronchioles and alveoli.

. Bronchioles and alveoli are enclosed in a pair of lungs.

. The rib cage, muscles associated with the rib cage and diaphragm, all
help in inhalation and exhalation of gases.

. Exchange of gases takes place between an alveolar surface and
surrounding blood vessels.

. Alveoli provide a large surface area for exchange of gases.

The human respiratory system is composed of a pair of lungs. These are attached to a s
which open on the outside through the nostrils.
Following are the main structures in the human respiratory system:

1. Nostrils: There are two nostrils which converge to form a nasal passage. The inner
nostrils is lined by hair and remains wet due to mucus secretion. The mucus and th
filtering the dust particles out from inhaled air. Further, air is warmed up when it ent
passage.

2. Pharynx: It is a tube-like structure which continues after the nasal passage.

3. Larynx: This part comes after the pharynx. This is also called voice box.

4. Trachea: This is composed of rings of cartilage. Cartilaginous rings prevent the coll
the absence of air.

5. Bronchi: A pair of bronchi comes out from the trachea, with one bronchus going to

6. Bronchioles: A bronchus divides into branches and sub-branches inside the lung.

T Alunnlic- Thoaea arn air onane At tha and Af hranchialane Tha alvanhiie e namannead Af A
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Mechanism of Respiration

Breathing in humans is facilitated by the action of internal intercostal
and external intercostal muscles attached to the ribs and the
diaphragm.

When the dome-shaped diaphragm contracts and becomes flattened
and the rib cage is expanded due to the action of intercostal muscles,
the volume of the lungs increases, pressure there drops down and the
air from outside gushes in. This is inhalation.

To exhale, the diaphragm relaxes, becomes dome-shaped again, chest
cavity contracts due to the action of intercostal muscles, the volume
inside the lungs decreases, pressure increases and the air is forced out
of the lungs.

Inhaled air increases the concentration of oxygen in the alveoli, so
oxygen simply diffuses into the surrounding blood vessels.

Blood coming from cells has more concentration of carbon dioxide than
outside air and thus carbon dioxide simply diffuses out of the blood
vessels into the alveoli.

Thus, breathing takes place due to the combined action of intercostal
muscles and diaphragm while the exchange of gases takes place due
to simple diffusion.

EXHALATION INHALATION

o Lung e Ribs e Diaphram
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. The process of taking in air rich in oxygen is called inhalation.
. Similarly, the process of giving out air rich in carbon dioxide is

called exhalation.

. One breath comprises one inhalation and one exhalation.

. A person breathes several times in a day.

. The number of times a person breathes in one minute is termed as

his/her breathing rate.

Diffusion

Diffusion is the movement of molecules from high
concentration area to the low concentration area without

spending any energy.

THE AARYANS



DR. NIDHI SEHGAL

Cellular Respiration

Cellular respiration is set of metabolic reactions occurring
inside the cells to convert biochemical energy obtained from
the food into a chemical compound called adenosine
triphosphate (ATP).

Metabolism refers to a set of chemical reactions carried out for
maintaining the living state of the cells in an organism. These can be
divided into two categories:

Catabolism — the process of breaking molecules to obtain energy.

Anabolism — the process of synthesizing all compounds required by
the cells.

Therefore, respiration is a catabolic process, which breaks large
molecules into smaller ones, releasing energy to fuel cellular activities.

Glycolysis, Krebs cycle and electron transport chain are the important
processes of the cellular respiration.

Chemical energy

Electron (hydrogen) |
transport system |

-— ww >

Cellular Respiration
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Aerobic Respiration

Aerobic respiration is a process in which the food i.e. glucose
is converted into energy in the presence of oxygen.

. The general equation of aerobic respiration as a whole is as given
below-

Glucose + oxygen =Carbon-dioxide + Water + Energy

. This type of respiration takes place in animals, plants and other living
organisms.

Respiration in Lower Animals

Lower animals lack a sophisticated respiratory system like lungs,
alveoli etc.

Respiration in them takes place by simple exchange mechanisms.
. Animals like earthworms take in gases through their skin.
. Fishes have gills for gaseous exchange.

. Insects have a tracheal system, which is a network of tubes, through
which air circulates and gaseous exchange takes place.

. Frogs breathe through their skin when in water and through their lungs
when on land.

Respiration in Muscles

. Respiration in muscles can be anaerobic when there is not enough
oxygen.

. Glucose gets broken down to carbon dioxide and lactic acid.

. This results in the accumulation of lactic acid that makes the muscles
sore.
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. This type of anaerobic respiration is also known as lactic acid
fermentation.

ATP

. ltis the energy currency of the cell.
. ATP stands for Adenosine Tri-Phosphate.

. This molecule is created as a result reaction like photosynthesis,
respiration etc.

. The three phosphate bonds present in the molecule are high energy
bonds and when they are broken, a large amount of energy is released.

. Such released energy is then used for other metabolic reactions.

Adenine

X )
|
High energy bonds

Ribose

Respiration in Plants

. Unlike animals and humans, plants do not have any specialized
structures for gaseous exchange

. They have stomata (present in leaves) and lenticels (present in stems)
which are involved in the exchange of gases.

. Compared to animals, plant roots, stems, and leaves respire at a very
lower rate.
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Transpiration

. Transpiration is a biological process in which water is lost in the form of
water vapour from the aerial parts of the plants.

. This process occurs mainly through the stomata where the exchange of
gases (oxygen and carbon dioxide) occurs.

. Transpiration helps in the transportation of water from roots to upper
parts of plants and this is explained by ‘transpirational pull theory’.

. Loss of water, especially from leaves, acts as a straw effect and pulls
water upwards from roots.

. Transpiration also acts as an excretory mechanism in plants as it helps
to get rid of excess water.

Why Do We Need Lungs

. In unicellular organisms like an amoeba exchange of gases takes place
through a general body surface by osmosis.

. In lower animals like an earthworm, the gaseous exchange takes place
through their moist skin.

. The requirement of oxygen is sufficiently met by these ways.

But as the animal starts becoming more and more complex, for
example, human, the requirement of oxygen cannot be met alone by
diffusion.

Moreover, diffusion will not be able to supply oxygen to the deep-
seated cells.

. This difficulty has led to the evolution of a more complex mechanism of
gaseous exchange and that is the development of lungs.

. The alveoli present in the lungs provide a large surface area required
for the necessary gas exchange.
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Try the following questions:
Question 1 What is breathing?

Question 2 Write two points of difference between respiration in
plants and respiration in animals?

Question 3 Which physical process is mainly responsible for
repiratory gases in leaves? Explain.

Question 4 How respiration is different from breathing?
Question 5 What are stomata and lenticels

Question 6 Explain the mechanism of gaseous exchange
between tissue and blood?

THE AARYANS



-DR. NIDHI SEHGAL
CHAPTER- THE FUNDAMENTAL UNIT OF LIFE CELL

DAY-1 ACTIVITY

What you'll need:

TEXT BOOK NCERT (SCIENCE),

NOTE BOOK (SCIENCE),

What you'll do:

First read and understand the notes/NCERT (SCIENCE), then try to solve the given assignments (in NOTE BOOK -
SCIENCE), and scale your preparedness for your PA_1 examination.

CELL
It is the structural and functional unit of life.
. Cell is termed as the structural unit of life as it provides structure to our body.
. Cell is considered as the functional unit of life as all the functions of the body take
place at cell level.
DISCOVERY OF CELL:
. Discovered by Robert Hooke in 1665.
. Robert Brown in 1831 discovered the nucleus in the cell.

CELL THEORY:

Cell theory was presented by Schleiden (1838) and Schwann (1839).
Cell theory states that:

. All living organisms are composed of cells.
. Cell is the fundamental unit of life.
. All new cells come from pre-existing cells.

INSTRUMENT FOR STUDYING CELL

. Microscope is the most common optical instrument used to observe cellular organization of
living organisms.
. There are many different kind of microscopes which can be broadly divided into two
categories:-----

i) Light microscope

i) Electrone microscope

TYPES OF ORGANISMS ON THE BASIS OF NUMBER OF CELLS
There are two kinds of organisms on the basis of cells:

(i) Unicellular Organisms: The organisms that are made up of single cell and may constitute a
whole organism, are named as unicellular organisms.
For example: Amoeba, Paramecium, bacteria, etc.

(ii) Multicellular Organisms: The organisms which are composed of a collection of cells that
assume function in a coordinated manner, with different cells specialized to perform particular
tasks in the body, are named as multicellular organisms.

For example: Plants, human beings, animals, etc.



SHAPE AND SIZE OF CELLS
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. Cells vary in shape and size. They may be oval, spherical, rectangular, spindle shaped, or
totally irregular like the nerve cell.
. The size of cell also varies in different organisms. Most of the cells are microscopic in size

like red blood cells (RBC) while some cells are fairly large like nerve cells.

TYPES OF CELLS

e The cells can be categorized in two types:
1. Prokaryotic Cell 2. Eukaryotic Cell

1. Prokaryotic cell
Prokaryotic cells are cells in which true nucleus is absent. They are primitive and
incomplete cells. Prokaryotes are always unicellular organisms. For example,
archaebacteria, bacteria, blue green algae are all prokaryotes.

Cell wall

Plasma
Membrane
LY

1
Plasmid y Nucleoid

Flagellum

2. Eukaryotic Cell
Eukaryobc cells are the cells in which true nucleus is present. They are advanced and
complete cells. Eukaryotes include all living organisms (both unicellular and multicellular
organisms) except bactera and blue green algae.

S. No.

Prokaryotic cell

nucleus

endoplasmic
reticulum

cytoplasm

cytoskeleton
yio ribosomes

FEukaryotic cell

- DIFFERENCE BETWEEN PROKARYOTIC AND EUKARYOTIC CELLS:

Prokaryotic cell

Size of cell is generally small (1-10 mm).

Nucleus is absent.

It contains single chromosome.

Nucleolus is absent.

Eukaryotic cell
Size of cell is generally large (5-100 mm).

Nucleus is present.

It contains more than one chromosome.

Nucleolus is present.
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Memrane bound cell organelles are absent. Memrane bound cell organelles such as
mitochondria, plastids, endoplasmic reticulum,
golgi apparatus, lysosomes, etc., are present.

Cell division takes place by fission or Cell division takes place by mitotic or meiotic cell
budding. division.

Try the following questions:

Q1. Name the scientist who presented the cell theory?

Q2. Name the scientist who introduced the term ‘cell’. In which year he gave this findings?
Q3. What is the source of light in electrone microscope?

Q4. Which unicellular organism has irregular shape?

Q5. Which instrument is most commonly used to observe the cellular organization of living
organisms?

Q6. Give suitable title to given figure:

Q7. Study thr relationship between first two words and suggest a suitable word for fourth place:
(a) Eukaryotic Cell : Nucleus :: Prokaryotic Cell : .......ccvveerieennnnnnee.
(b) Unicellular Organisms : single cell :: Unicellular Organisms : .......ccccccccevvveennnnn.
(c) Robert Hooke : cell :: Robert Brown : ......cccccccvveeeenennnn.
(d) Light microscope: small instrument :: Electrone microscope : ........cccceeeeeecnveenen.
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About the Author
Gregorio Lopez Y Fuentes was bom on July 11, 1897 at Lanzarote in the Canary [

[larids. He first went to sea as a deck boy with his father af the age of fen. AS" {8
a teenager, Fuentes worked on cargo ships that went out of the Canary Island f |
Trinidad and Puerto Rico. He also sailed to the Spanish parts of Valencia and'}

Sevillato South America. He migrated permanently to Cuba at the age of twenty
two, Puentes, a lifelong cigar smoker, died from cancer in 2002 at the age of 103

years.



- B Story At a Glance

‘Aletter to God s astory of extreme faith in God. The writer G.L. Fuentes has tried to depict the fait™
{apoor and simple farmer in God. Lencho was an honest and hardworking farmer. He was shocked ;
fiotice that his crop was ruined. He turned to God for getting some help. He wrote a letter to Ge
When an employee of the post office chanced to se the letter addressed to God, he made funto the m "
‘who had written that letter but his boss a serious man who did not take the letter lightly. He W "
impressed by the extreme faith of the man and wished to have the same faith. He decided to answer tm 5-
letter as he was moved by the demand of the farmer. He collected money from his employees to give m
charity. He was able to collectonly seventy pesos and thought thatthe farmer would be glad t feceive
the money, But to his utter disappointment, he ws shocked to notice that it made Lencho mgry Who k

wrote another leter o God but with a warning not o snd the money by post. He considered th
officials ‘2 bunch of crooks’ who had stolen thirty pesos rom the hundred pesos sent by God i
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Theme of the Story. |
- Thisis a story of a hard working farmer Lencho. He is expecting a good harvest this yea
The rain does come bringing a brief happiness. However, a hailstorm follows the rain
all hus crops. Being deeply hurt, he looks toward God. Having an unshaken faith m ¢
a letter to Him demanding one hundred pesos. This amount 1s sufficient enough t0
again. He posts it. The postman has a hearty laugh when he reads it and shows it to the'pos
The postmaster, being a generous man, decides to help Lencho. He gives a part of hus
collects money from the employees. He sends seventy pesos to Lencho. Lencho's
was momentary when he counts the money. God can’t deceive him, it 18 the work of
employees. He writes another letter to God asking Him not to send the remaining 30 pesos
post office employees are a ‘bunch of crooks’.
The lesson shows three things. It shows Lencho’s firm faith in God. His faith 1s rewarded
elpers are human beings. Secondly, 1t shows the utter mnocence of the farmer, Le
‘the lesson gives a message that sometimes even your generosity is not recognised. You'
get any credit for youLgenerosity and kindness. But on the other hand, you may be u

28 a ‘bunch of crooks’.
M"‘"”J p = R




N
MAIN CHARACTERS

e LENCHO: A hardworking farmer , theist , confident,
naive and determined person.

e Postmaster: An amiable , lovable,
® co-operative and likeable person



The house - the only one in the entire valley - sat on the crest
(top of a hill) of a low hill. From this height one could see the
river and the field of ripe corn dotted with the flowers that

always promised a good harvest.

Crest : top of a hill

The word faith is often used as a
subsitute for hope, trust or belief.
Harvest:the process or period of
gathering in crops



The only thing the earth needed was a downpour (heavy |
rainfall) or at least a shower (mild rain). Throughout the
morning Lencho - who knew his fields intimately (closely) -
had done nothing else but see the sky towards the north-
east.

e Downpour : heavy rainfall
e Shower: mild rain

e Intimately: closely



“Now we’re really going to get some water, woman.” The

woman who was preparing supper, replied, “Yes, God willing”.
The older boys were working in the field, while the smaller

ones were playing near the house until the woman called to
them all, “Come for dinner”. It was during the meal that, just as

Lencho had predicted, big drops of rain began to fall.

e Supper:an evening meal
e Predicted: fore told



approaching. The air was fresh and sweet. The man went out for
no other reason than to have the pleasure of feeling the rain on his
body, and when he returned he exclaimed, “These aren’t
raindrops falling from the sky, they are new coins. The big drops
are ten cent pieces and the little ones are fives.”

e Huge:very big

e Approaching: to come near
® Pleasure:happiness

e Returned; came back

e Exclaimed:cried with surprise



With a satisfied expression he regarded the field of ripe corn with
its flowers, draped (covered with a cloth) in a curtdin of rain. But
suddenly a strong wind began to blow and along with the rain
very large hailstones began to fall. These truly did resemble new
silver coins. The boys, exposing themselves to the rain, ran out to
collect the frozen pearls.

e satisfied: contented

e Expression :show of feelings
e Regarded: thought

® Draped:covered completely
e Curtain: veil

e Hailstones: rain of snow

e resemble: to look like something
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Not a leaf remained on the trees. The corn was totally destroyed. |
The flowers were gone from the plants. its. Lencho’s soul was filled
with sadness. When the storm had passed, he stood in the
middle of the field and said to his sons, “A plague of locusts
(insects which fly in groups and destroy crops) would have left
more than this. The hail has left nothing. This year we will have

no corn.”

e Destroyed:spoiled

® Plague of locusts:insects which fly in groups and
destroy crops.

e Soul: spiritual part of a person believed to exist after

death



e Solitary:alone
e Upset : worried
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“Don’t be so upset, even though this seems like a total loss.
Remember, no one dies of hunger.” “That’s what they say: no
one dies of hunger.” S

e Now Lencho has a positive attitude he consoled his
family by reminding that no one never dies of
hunger.This shows his un shaken faith in god and his
mercy



All through the night, Lencho thought only of his one hope: the
help of God, whose eyes, as he had been instructed, see

everything, even what is deep in one’s conscience (an inner sense

of right and wrong). Lencho was an ox of a man, working like an
animal in the fields, but still he knew how to write.

e Conscience:an inner sense of right or wrong

e Instructed: directed
® Through:from the beginning to the end



The following Sunday, at daybreak, he began to write a letter
which he himself would carry to town and place in the mail.

It was nothing less than a letter to God.

® Daybreak:sunrise



“God,” he wrote, “if you don’t help me, my family and | will go_
hungry this year. | need a hundred pesos (currency of many Latin

American countries) in order to sow my field again and to live
until the crop comes, because the hailstorm... "

® Pesos:currency of many Latin American countries



He wrote ‘To God’ on the envelope,
put the Iletter inside and, still
troubled, went to town. At the post

office, he placed a stamp on the
letter and dropped it into the
mailbox.

* Dropped:put in
® Troubled: disturbed
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immediately he turned serious and, tapping the letter on his

desk, commented, “What faith! | wish I had the faith of the man
letter. Starting up a correspondence

57’
I

who wrote this

(communication by exchange of letters) with God

e Correspondence: communication by exchange of

letters
e Tapping: stroking



So, in order not to shake the writer’s faith in God,
the postmaster came up with an idea: answer the
letter. But when he opened it, it was evident that to
answer it he needed something more than goodwill,

ink and paper.

e Here ,the postman decided to answer the letter as he
was deeply impressed by sender’s

e Un shaken faith in god,so he collected money

e By giving a part of his salary and taking contribution of
his employees as an act of charity.



1t was impossblefor him to gather together the

hundred pesos, S0 he was able to send the

S  farmer only a ittle more than half, e put the
o money in an envelope addressed to Lencho ana

with it a letter containing only a single word as

a signature: God.




who handed the letter to him while the post mast of a man
who has performed a good deed, looked on from his office.er,
experiencing the contentment (satisfaction)

e Contentment:satisfaction
e Deed:act



seeing - C
but he became angry when he counted the
money. God could not have made a mistake,

nor could he have denied Lencho what he
. had requested.

e Slightest:not even a little
® Denied: refused



Immediately, Lencho went up to the
window to ask for paper and ink. On the
public writing-table, he started to write,
with much wrinkling of his brow, taused
by the effort he had to make to express his

.
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(cheats). Lencho.”

e Bunch:group
e Crooks:cheats
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